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GroupWise 6.5 
Support Pack 4
February 28, 2005

Overview
The information in this Readme file pertains to Novell® GroupWise® 6.5 Support Pack 4. This 
Support Pack contains updates for all components contained in the GroupWise 6.5 product. 
However, this Support Pack does not contain updates for GroupWise Messenger. GroupWise 
Messenger 1.0 Support Pack 4 is a separate download.

GroupWise 6.5 Support Pack 4 includes the NetWare®, Linux*, and Windows* GroupWise 6.5 
software in a single Support Pack. The NetWare and Windows software is provided in one set of 
downloads; the Linux software, including the Cross-Platform client for Linux and Macintosh*, is 
provided in a separate set of downloads. 

For information on the latest Support Pack issues, see the Consolidated Support Pack 12 Readme 
Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10094148.htm).

1.0  NetWare/Windows: Support Pack Installation

1.1  GroupWise Version Information
GroupWise 6.5 Support Pack 4 for NetWare and Windows can be applied to the following 
GroupWise versions in your software distribution directory:

GroupWise 6.5 (original version)

GroupWise 6.5.1 (Support Pack 1)

GroupWise 6.5.2 (Support Pack 2)

GroupWise 6.5.3 (Support Pack 3)

When you update the software distribution directory, all GroupWise components must be updated 
to keep them at the same version level.

When you install updated software for any GroupWise agent on a server where multiple agents are 
running, update the software for all GroupWise agents on that server. Do not run different versions 
of agent software on the same server.

1.2  Prerequisites
Before installing GroupWise 6.5 Support Pack 4 for NetWare and Windows:

Ensure that the network login account used to apply the Support Pack has Read, Write, Create, 
and Erase rights to the GroupWise software distribution directory.

Ensure that users do not access the software distribution directory during the update process.
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Verify that the GroupWise software distribution directory and files are not flagged Read-Only.

1.3  Downloading and Installing the NetWare/Windows Support Pack
GroupWise 6.5 Support Pack 4 for NetWare and Windows is available as two self-extracting (.exe) 
files, one for administrative files and one for Windows client files. English-only and multilingual 
versions are available. You can download the Support Pack from the GroupWise 6.5 Product 
Updates page (http://support.novell.com/filefinder/16963/index.html).

1.3.1  Downloading the Installing the Administration Software

1 From the list of Support Packs, download GroupWise 6.5 Admin SP4 (gw654e.exe for 
English only or gw654m.exe for multilingual) into a temporary directory.

2 Extract the .exe file into a directory at the root of your local drive or to a network server drive 
that can handle long pathnames.

The compressed file contains directory paths that could exceed DOS limits. 

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the 
Support Pack files.

4 Select the setup.exe file, then click OK to run the GroupWise Installation Advisor.

5 Click Create or Update a GroupWise system.

6 Follow the on-screen instructions to update the software distribution directory and the 
administration, agent, and client software that is in production.

7 After applying the Support Pack on NetWare servers where GroupWise agents are running, 
restart the servers to ensure that all updated NLMTM programs are loaded.

This resolves any errors you might see during the update process.

For complete installation instructions, see the GroupWise 6.5 Installation Guide on the GroupWise 
6.5 Documentation Web page (http://www.novell.com/documentation/gw65).

1.3.2  Downloading and Installing the Windows Client Software

1 From the list of Support Packs, download GroupWise 6.5 Client SP4 (gw654ce.exe for 
English only or gw654cm.exe for multilingual) into a temporary directory on your 
workstation.

2 Extract the .exe file into a directory at the root of your local drive.

The compressed file contains directory paths that could exceed DOS limits. 

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the 
Support Pack files.

4 Select the setup.exe file, then click OK to run the GroupWise client Setup program.

5 Follow the on-screen instructions to update the client software on your workstation.

For complete installation instructions, see the GroupWise 6.5 Installation Guide on the GroupWise 
6.5 Documentation Web page (http://www.novell.com/documentation/gw65).
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2.0  Linux: Support Pack Installation

2.1  GroupWise Version Information
GroupWise 6.5 Support Pack 4 for Linux can be applied to the following GroupWise versions in 
your software distribution directory:

GroupWise 6.5 for Linux (original version)

GroupWise 6.5.2 for Linux (Support Pack 2)

GroupWise 6.5.3 (Support Pack 3)
NOTE: GroupWise 6.5 for Linux and GroupWise 6.5.2 for Linux were Linux-only releases. (There was no 
GroupWise 6.5.1 for Linux.) GroupWise 6.5.3 and GroupWise 6.5.4 include all supported platforms (NetWare, 
Linux, and Windows) in the same Support Pack release.

The GroupWise 6.5 software distribution directory must already exist in order to install Support 
Pack 4. When you update the software distribution directory, all GroupWise components must be 
updated to keep them at the same version level.

When you install updated software for any GroupWise agent on a server where multiple agents are 
running, update the software for all GroupWise agents on that server. Do not run different versions 
of agent software on the same server.

2.2  Downloading and Installing the Linux Support Pack
GroupWise 6.5 Support Pack 4 for Linux is available as compressed tar files, one for the 
GroupWise administration software, one for the Cross-Platform client for Linux, and one for the 
Cross-Platform client for Macintosh. All languages are included. You can download the Support 
Pack from the GroupWise 6.5 Product Updates page (http://support.novell.com/filefinder/16963/
index.html).

2.2.1  Downloading and Installing the Administration Software

The administration software includes the GroupWise agents and the GroupWise Administrator 
snap-in to ConsoleOne®.

1 Download the compressed tar file (gw654lnx.tar.gz) to a temporary directory on your Linux 
server.

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:

gzip -d gw654lnx.tar.gz
tar -xvf gw654lnx.tar
The result is a directory named gw654lnx.

3 Change to the gw654lnx directory.

4 Enter the following command:

xhost + localhost
5 In the same window, become root by entering su and the root password.

6 Start the GroupWise Installation Advisor:

./install
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7 Click Create or Update a GroupWise System.

8 Follow the on-screen instructions to update the software distribution directory and the 
administration and agent software that is in production.

For complete installation instructions, see the GroupWise 6.5 Installation Guide on the GroupWise 
6.5 Documentation Web page (http://www.novell.com/documentation/gw65).

2.2.2  Downloading and Installing the Cross-Platform Client for Linux

1 Download the compressed tar file (gw654clnx.tar.gz) to a temporary directory on your Linux 
workstation.

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following commands to uncompress and untar the downloaded file:

gzip -d gw654clnx.tar.gz
tar -xvf gw654clnx.tar
The result is a directory named gw654clnx.

3 Change to the gw654clnx directory.

4 Run the GroupWise Setup Advisor to install the GroupWise Cross-Platform client software:

./install
5 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 

desktop.

For complete installation instructions, see the GroupWise 6.5 Installation Guide on the GroupWise 
6.5 Documentation Web page (http://www.novell.com/documentation/gw65).

2.2.3  Downloading and Installing the Cross-Platform Client for Macintosh

1 Download the StuffIt file (gw654cmac.sit) to a temporary directory on your Macintosh 
workstation.

2 At your Macintosh workstation, browse to the gw654cmac.sit file.

3 Double-click the gw654cmac.sit file to uncompress the downloaded file.

The result is a directory named gw654cmac.

4 Change to the gw654cmac directory.

5 Double-click the GroupWise.app.sit file to install the GroupWise Cross-Platform client 
software.

6 To start the Cross-Platform client after installation, click the GroupWise icon on your 
Macintosh desktop.

For complete installation instructions, see the GroupWise 6.5 Installation Guide on the GroupWise 
6.5 Documentation Web page (http://www.novell.com/documentation/gw65).
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3.0  Installation Issues

3.1  General Installation Issues

3.1.1  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a 
common library. If you plan to run these applications on the same Web server, you must update all 
three before any of them can work properly.

3.1.2  Wireless Device Support for WebAccess and Monitor

The GroupWise® WebAccess and Monitor software included in GroupWise 6.5 Support Pack 4 
supports the following wireless devices:

WAP-enabled wireless devices that use HDML 3 or WML 1.1 compatible microbrowsers

Palm OS* devices

We are continually evaluating and adding support. As we add support for additional devices, we 
post the updates on the Novell GroupWise Wireless page (http://www.novell.com/wireless). We 
encourage you to check this site for updates and news.

3.1.3  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

3.2  NetWare/Windows Installation Issues

3.2.1  Recommendation for Overwriting Newer Files

When the gwpo.dc and ngwguard.dc files from the original Novell® GroupWise 6.5 release are 
installed, they receive the date and time when they are installed rather than retaining their original 
date and time. As a result, they might have a newer date and time than the ngwguard.dc files in 
Support Pack 4. If they do, you receive the following message:

“The files you are installing are older than the files on your system. Do you want to replace these 
files?”

Typically you should respond No to such a prompt, but in this case you should respond Yes so that 
the Support Pack version of the.dc files is installed. If necessary, you can manually copy these files 
from the original GroupWise 6.5 Administration CD to the corresponding location in the software 
distribution directory:

\po\ngwguard.dc
\client\win32\ngwguard.dc

You might also see this message if you are installing GroupWise 6.5 Support Pack 4 as an update 
to GroupWise 6.0 where Support Pack 3 or later has been installed. Again, respond Yes to 
overwrite newer files.

As an alternative, you can create a new software distribution directory for the GroupWise 6.5 
Support Pack 4 files.
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3.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet 
Agent, WebAccess Agent, Monitor Agent) to a NetWare® server from a Windows* XP machine 
where Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later 
installed on the Windows machine. If you have an earlier Novell Client, the GroupWise 
Installation Advisor claims that it cannot find some of the directories to which you want to install 
software.

3.2.3  Windows 2000 Service Pack 2 or Later Required for Agents

If the GroupWise Post Office Agent, Message Transfer Agent, Internet Agent, and WebAccess 
Agent are installed on Windows 2000 and the GroupWise domain and/or post office directories 
accessed by the agents are on NetWare servers, you need to apply Windows 2000 Service Pack 2 
or later on the Windows servers. You can download Windows 2000 Service Packs from Microsoft* 
(http://windowsupdate.microsoft.com).
NOTE: If, as required with the initial release of GroupWise 6, you already installed Microsoft HotFix Q266066 
on all Windows 2000 servers where GroupWise agents run, you do not need to apply Windows 2000 Service 
Pack 2 or later.

3.2.4  GroupWise Version Compatibility

If you still have GroupWise 4.1 domains or post offices in your GroupWise system, you must 
update them to at least GroupWise 5.2 before updating your primary domain to GroupWise 6.5. If 
you try to update a 4.1 domain or post office to 6.5 after the primary domain has already been 
updated to 6.5, you need to rebuild each 4.1 secondary domain database using the GroupWise 6.5 
Support Pack 3 or later snap-ins to ConsoleOne®, and you also need to have each rebuilt secondary 
domain database manually edited by Novell Support before it will function correctly with the 6.5 
primary domain. 

3.3  Linux Installation Issues

3.3.1  SUSE LINUX Enterprise Server 9

The GroupWise agents are now supported on SUSE® LINUX Enterprise Server (SLES) 9. 

You can also run ConsoleOne on SLES 9 with the proper preparation. 

If ConsoleOne is already installed and you are running Novell eDirectoryTM 8.7.3 or earlier, make 
sure that you install the GroupWise Administrator snap-in to ConsoleOne before you try to run 
ConsoleOne. This installation updates the version of the JRE to the required version.

If you need to install ConsoleOne on a server where you are running an eDirectory version later 
than 8.7.3, you need to make a simple modification to the installation script. 

1 After downloading ConsoleOne and untarring it, change to the Linux directory.

2 Edit the c1-install script.

3 Locate the nds_version line.

4 Change 8.7.3 to the version of eDirectory that you are running (for example, 8.7.3.2 or 
8.7.3.3).

5 Save and exit the file, then run the script to install ConsoleOne.

6 Install the GroupWise Administrator snap-in to ConsoleOne.
6   

http://windowsupdate.microsoft.com


    Novell Confidential                                                                                            Manual (ENU)  6 October 2004
3.3.2  Novell Open Enterprise Server

Open Enterprise Server (OES) Linux includes Apache and Tomcat. When you run the GroupWise 
Installation Advisor to install WebAccess and Monitor, the installation options that include 
Apache and Tomcat, as shown in the product documentation, are not offered when you are 
installing Support Pack 4 on OES because Apache and Tomcat are already set up and running.

OES also uses different commands to start and stop Apache:

apache2 start
apache2 restart
apache2 stop

3.3.3  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The Update section of the GroupWise 6.5 Installation Guide provides instructions for moving from 
NetWare or Windows to Linux*. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.

4.0  Administration Issues

4.1  General Administration Issues

4.1.1  ConsoleOne Version

The version of ConsoleOne included with GroupWise has been updated from 1.36c to 1.36d.

4.1.2  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot 
use an IP address or DNS hostname.

4.1.3  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check 
the GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.

4.2  NetWare/Windows Administration Issues

4.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even 
to files that are not specific to GroupWise (such as SSL certificates and key files).
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4.2.2  ConsoleOne on Windows NT 

If you will run ConsoleOne on Windows NT* 4, you must install NT 4 Service Pack 6 before you 
install ConsoleOne.

4.2.3  GWTSA and Duplicate Source Directories

GWTSA handles situations where the same directory names are used on different volumes to back 
up by numbering the instances. For example:

Original GWTSA
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:

Each instance is numbered and DOM is in all uppercase letters. After updating GWTSA with 
Support Pack 1 or later, you must re-create your backup jobs because the path has changed.

4.2.4  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.

4.2.5  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.

To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.

4.3  Linux Administration Issues

4.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

4.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

However, if you update a GroupWise 4.1 system and move it to Linux, you might see uppercase 
letters in database names. This is not a problem. The Database Copy (DBCopy) utility that you use 
to move domains and post office to Linux handles any uppercase/lowercase issues that might arise, 
so you should not manually rename any databases that have been copied to Linux using DBCopy.
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4.3.3  UNC Paths in ConsoleOne

On Linux, ConsoleOne translates UNC paths into Linux paths.

4.3.4  Display Problem with ConsoleOne Property Page Tabs

If you run ConsoleOne on SUSE LINUX 9 with Ximian® Desktop 2 installed, the label text on the 
property tabs does not display. As a workaround, click the tab to select it, then use the Up-arrow 
and Down-arrow keys to display each property page until you reach the one you want.

4.3.5  Unavailable Administration Features

GroupWise 6.5 on Linux does not include the following administration features that are available 
in GroupWise 6.5 on NetWare and Windows:

Import/Export utility in ConsoleOne

Document Properties Management feature in ConsoleOne

5.0  Agent Issues

5.1  General Agent Issues

5.1.1  POA Redirection Enhancement

You can now configure the POA to control where users are redirected, regardless of where users 
are located. In the past, a POA configured with both an internal IP address and a proxy IP address 
automatically redirected internal users to internal IP addresses and external users to external IP 
addresses. Now, you can configure two POA objects for a post office, one with only an internal IP 
address and one with only a proxy IP address. GroupWise clients that access the internal IP address 
are redirected internally, no matter where the users are located. Clients that access the proxy IP 
address are redirected externally, no matter where the users are located. This overrides the POA’s 
built-in capability of detecting where users are logging in from and redirecting them accordingly. 

For setup instructions, see Controlling Client Redirection Inside and Outside Your Firewall in Post 
Office Agent in the GroupWise 6.5 Administration Guide.

5.2  NetWare/Windows Agent Issues

5.2.1  POA Slows Down

If you are running the POA on NetWare 6.0 Support Pack 2 on a multiprocessor such as a Dell* 
6650 PowerEdge* or an IBM* Netfinity*, the POA might gradually slow down after a few hours 
or a day, depending on its load. GroupWise client users could also experience extremely slow 
response time from the POA. Update from NetWare 6.0 Support Pack 2 to Support Pack 3.

5.2.2  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used by the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port in ConsoleOne.
9
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5.3  Linux Agent Issues

5.3.1  libXm.so.3 Error

If you try to start the POA or MTA on a server where The X Window System* and OpenMotif are 
not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and OpenMotif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.

6.0  Client Issues

6.1  Windows Client Issues

6.1.1  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

6.1.2  New JAWS Script Available

Users of the JAWS screen reader should install the new JAWS script available in GroupWise 6.5 
Support Pack 3 or later. Copy the groupwise.jsb file from the \client\jaws directory of the Support 
Pack to the \jaws510\settings\enu directory on your workstation. This JAWS script is necessary in 
order to take advantage of many of the Section 508 accessibility fixes in this Support Pack.

6.1.3  NetWare 5.1 SP1 Compatibility for Client Installation

If you are using the AutoUpdate feature for installing the GroupWise 6.5 client, you might 
encounter an error if you are installing the client from a NetWare 5.1 server where a Support Pack 
has been installed. The setupip.exe program used during the AutoUpdate process might not run 
correctly.

To resolve the problem, you must modify the magnus.conf file located in the following directory:

sys:\novonyx\suitespot\http-web_server_name\config 

by adding the following line:

MaximumFilesReturnedInIndex 500

Then run the client installation again.
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6.2  Cross-Platform Client Issues

6.2.1  Linux Client Installation on Red Hat 8

On Red Hat* 8, you cannot use the main GroupWise Installation Advisor (the install executable at 
the root of the Support Pack) to install the Cross-Platform client. Instead, you can run the install 
executable located in /client/linux or you can install the novell-groupwise-gwclient-6.5.4 RPM 
located in the same directory.

6.2.2  Cross-Platform Client Performance

For best performance, run the Cross-Platform client in Caching mode. It is noticeably faster than 
Online mode.

6.2.3  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If 
pending requests from the root session remain when you log in as a regular user, regular user 
requests get backed up behind the root requests, which cannot be processed while you are logged 
in as a regular user. To resolve any problems, run the client as root again so that all messages get 
synchronized, then run as a regular user thereafter to prevent further problems.

6.2.4  HTML Message Display

Some HTML-formatted messages are not rendered correctly in the Cross-Platform client.

6.2.5  Some Settings Not Saved

In Online mode, custom column sort settings are not saved unless the Cross-Platform client is 
connected to a GroupWise 6.5 for Linux POA or later. The problem will be resolved for NetWare 
and Windows POAs in a future Support Pack.

6.2.6  “Not Accepting Jobs” Print Error

This is a Java* error. A newer version of the JVM* resolves it. The print jobs print successfully in 
spite of the error message.

6.2.7  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

6.2.8  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh*, new messages 
might not display as bold in your mailbox. To resolve the problem, disable your user fonts, which 
are typically duplicates of your system fonts, or update to JVM 1.4.2 Update 1 or later.

6.2.9  Unavailable Client Features

The GroupWise Cross-Platform client does not currently provide some functionality that is 
available in the GroupWise Windows client, including:

Spell checking
11
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Rules

Categories

Viewers for attachments

Remote mode to support modem connections

S/MIME (encryption and digital signatures)

Document management

Additional functionality will be available in future releases of the Cross-Platform client.

7.0  Internet Agent Issues

7.1  General Internet Agent Issues

7.1.1  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for 
sending to distribution lists and resources if you set Internet Addressing to one of the following 
formats (which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain

last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the 
Internet Agent. The Internet Agent then successfully resolved the addresses and sent the messages 
back into the GroupWise system. Users did not notice the problem, but some administrators 
noticed unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If unnecessary traffic 
through the Internet Agent is a continuing problem, have users delete distribution lists and 
resources from their Frequent Contacts address books so that the correct address format is used for 
name completion in the future.

7.2  NetWare/Windows Internet Agent Issues
None.

7.3  Linux Internet Agent Issues

7.3.1  Installation Security

During installation, the Internet Agent Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s Trusted Root Certificate, which must be exported from the LDAP 
server, in order for LDAP authentication to take place (typically on port 636) during installation 
of the Internet Agent.
12   
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Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of the Internet Agent. After disabling the option, 
restart eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with 
Password and restart eDirectory again.

7.3.2  libXm.so.3 Error

If you try to start the Internet Agent on a server where The X Window System and OpenMotif are 
not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and OpenMotif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

8.0  WebAccess Issues

8.1  General WebAccess Issues

8.1.1  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or 
the Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 On the Security page (located on the Application tab), deselect the Use Client IP in Securing 
Sessions option. 

For information about this option, click Help on the Environment page.

3 Click OK to save the change.

8.1.2  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is 
set by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

8.1.3  “Browser Doesn’t Support Java” Error in the WebAccess Java Calendar

This error indicates a browser setup issue. You would encounter the same problem on any Web site 
that uses Java. Depending on your browser, check mozilla.org, sun.com, or other browser supplier 
for more information.
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8.1.4  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the 
/com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache, you can modify the httpd.conf file to remove the access that is 
provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

8.1.5  Preventing Unauthenticated Template Access

Under certain very specific circumstances, it is possible for a user to view WebAccess template 
files from a Web browser without logging in to WebAccess. There is no confidential information 
located in any of the template files that are accessible in this manner. 

In Support Pack 4, a line has been added to the webacc.cfg file to prevent such access:

Templates.requireAuthentication=true

With this new setting, unauthenticated users have no access to any WebAccess template files 
except for the Login page. If you have customized WebAccess templates for your own specialized 
use, this new setting causes your templates to be inaccessible, even if GroupWise authentication 
was not previously required. You can turn off the authentication requirement by changing the new 
line in the webacc.cfg file to:

Templates.requireAuthentication=false

400329

8.2  NetWare/Windows WebAccess Issues

8.2.1  Using the Latest Novell Client

If you receive an error during installation indicating that the nvweb.dll file cannot be found, update 
the workstation to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads page (http://download.novell.com/index.jsp).

8.2.2  Display Problems with Netscape 4.x

If you experience display problems using Netscape* 4.x with WebAccess, update to a later version 
of Netscape.

8.2.3  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages 
become part of the History cache and can be read by other users who have access to the same 
workstation. For solutions to this problem, see TID 10056452 in the Novell Knowledgebase (http:/
/support.novell.com/search/kb_index.htm).
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8.3  Linux WebAccess Issues

8.3.1  Novell Distribution of Apache and Tomcat

GroupWise 6.5 on Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution is installed in the following directories:

Apache: /var/opt/novell/http and /etc/opt/novell/http
Tomcat: /var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4

and is started using the following customized commands:

Tomcat: /etc/init.d/novell-tomcat4 start
Apache: /etc/init.d/novell-httpd start

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat if 
you want to install the Novell distribution. Select Install WebAccess Application if you do not 
want to install the Novell distribution of Apache and Tomcat because you have an existing Apache 
and Tomcat installation that you want to use with WebAccess.
NOTE: If you are installing on Novell Open Enterprise Server (OES), the option to install with Apache and 
Tomcat is not available. For more information, see Novell Open Enterprise Server.

If you install the Novell distribution on a server where a standard distribution of Apache and 
Tomcat is already installed and running, you will encounter a port conflict on port 80. You can 
resolve the port conflict by choosing to run one distribution or the other, or you can reconfigure 
one distribution or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in the 
/etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

8.3.2  Prolonged “Please Wait” Message during Installation

On slower machines, if you select Install WebAccess Application with Apache and Tomcat, your 
machine might appear to hang on the “Please Wait” message. Apache and Tomcat are being 
installed while the “Please Wait” message is displayed, before the WebAccess Application 
installation begins.

8.3.3  Installation Security

During installation, the WebAccess Installation program requires access to eDirectory by way of 
LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server’s Trusted Root Certificate, which must be exported from the LDAP server, in order 
for LDAP authentication to take place (typically on port 636) during installation of the 
WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of WebAccess. After disabling the option, restart 
15
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eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

8.3.4  Re-installation Issue

If you install WebAccess in an eDirectory context where the WebAccess objects already exist, a 
message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must 
customize the objects again after installing WebAccess on Linux. 

8.3.5  New WebAccess URLs

Existing users of the WebAccess are accustomed to accessing the following URLs:

Web Services page: Default index.html file of the Web server
WebAccess: http://web_server_address/servlet/webacc
WebPublisher: http://web_server_address/servlet/webpub

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
WebAccess: http://web_server_address/gw/webacc
WebPublisher: http://web_server_address/gw/webpub

As an added benefit, GroupWise 6.5 on Linux configures SSL for you, so that the following URLs 
provide SSL security without additional configuration on your part:

GroupWise-specific Web Services page: https://web_server_address/gw/index.html
WebAccess: https://web_server_address/gw/webacc
WebPublisher: https://web_server_address/gw/webpub

8.3.6  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 6.5 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

8.3.7  WebPublisher Template Settings Not Saved

Changes to the settings on the Templates page of the GroupWiseWebPublisher object in 
ConsoleOne are not saved to the webpub.cfg file. To work around this, after making changes on 
the Templates page, select a different property page on the GroupWiseWebPublisher object, then 
click OK or Apply to save the template settings correctly.

8.3.8  Commented Lines in Configuration Files

If you have commented out any lines in the WebAccess configuration file (webacc.cfg) or the 
WebPublisher configuration file (webpub.cfg), you should back up those files before installing 
Support Pack 4. If you use the Configure WebAccess Application option in the Installation 
program, those commented lines become uncommented and the settings return to their defaults. 
However, any other changes you have made to the configuration files are retained. You must 
comment out the lines again and edit the settings as needed, using the backup copies for reference.
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9.0  Monitor Issues

9.1  General Monitor Issues

9.1.1  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. If you 
reinstall the Monitor software, the monitor.xml file is backed up as monitor.001. To restore 
previous Monitor settings, remove the newly installed monitor.xml file and rename monitor.001 to 
monitor.xml.

9.2  Windows Monitor Issues
None.

9.3  Linux Monitor Issues

9.3.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues pertain to Monitor as well:

Novell Distribution of Apache and Tomcat
Prolonged “Please Wait” Message during Installation
Installation Security
Re-installation Issue

9.3.2  New Monitor URLs

If you’ve used Monitor on Windows, you are accustomed to accessing the following URLs:

Web Services page: Default index.html file of Web server
Monitor Web Console: http://web_server_address/servlet/gwmonitor

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
Monitor Web Console: http://web_server_address/gwmon/gwmonitor

9.3.3  Problem Starting Monitor on Red Hat 3 AS

If you encounter problems starting the Monitor Agent on Red Hat 3 AS, set the LC_ALL 
environment variable using one of the following commands:

export LC_ALL=C
export LC_ALL=POSIX
17
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10.0  International Issues

10.1  General International Issues

10.1.1  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

10.1.2  Double-Byte Characters in Passwords

Do not use double-byte character in users’ passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-
byte characters. However, the GroupWise client login does not allow entry of double-byte 
characters in passwords, so a user who was assigned a password with double-byte characters in 
ConsoleOne cannot type the double-byte characters when attempting to log in to GroupWise.

10.1.3  Euro Character in the Subject Field

If a WebAccess client user receives a message, task, or appointment with a Euro character in the 
Subject field, it might display as an upside-down question mark when viewed in the Java version 
of the Calendar. The issue resides with the user’s browser.

Netscape users need to upgrade to Netscape Communicator* 6.

Internet Explorer users need to be using at least version 3309 of the JVM. The latest JVM can be 
downloaded from the Microsoft Web site and installed on the user’s workstation. This JVM 
enables Internet Explorer 4.x and later to correctly display the Euro character.

10.1.4  Unicode Support in WebAccess

Unicode* support using UTF-8 encoding has been implemented in WebAccess to provide better 
support for international character sets. Unicode support enables users to intermix characters 
within the same message and have all character sets display correctly.

For Support Pack 4, Unicode support is not fully implemented for double-byte character set 
languages (DBCS languages). In order to correctly compose in a DBCS language, users need to 
set their browser accept language to the desired DBCS language. Also in Support Pack 4, 
intermixing two different DBCS languages is not supported. These limitations will be removed in 
the next major release of WebAccess.

If you will update to Support Pack 4 in stages, update the WebAccess Agent first throughout your 
system, then update the WebAccess Application. If the update to Unicode support causes 
undesirable side effects for your particular language or combination of languages, you can turn it 
off using the /utf8off startup switch with the WebAccess Agent. Then comment out the 
Charset.default setting in the webacc.cfg and webpub.cfg files. This procedure will not be 
necessary after Unicode support is fully supported for DBCS languages.

10.1.5  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does not 
work for some Web browsers. If you do not see the localized languages in the drop-down menu on 
the Web services page (index.html), set your Web browser’s character encoding to UTF-8. In some 
browsers, you can click View > Encoding to set the Web browser’s encoding.
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You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your Web browser’s character encoding for the new message window to UTF-8. 
You can do this by right-clicking in the new message window and then setting the encoding, or by 
clicking View > Encoding.

10.1.6  Help Display in Japanese WebAccess

If you click Help in the Japanese WebAccess client, the help text does not display properly. To 
correct the problem, edit the \apache2\conf\httpd.conf file and comment out the following lines:

ForceLanguagePriorityPreferFallback
AddDefaultCharset

Then restart Apache.

10.2  NetWare/Windows International Issues

10.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

10.2.2  RichWin and GroupWise 6.5

If you use RichWin in combination with GroupWise 6.5, be sure to run RichWin first, then run 
GroupWise.

10.3  Linux International Issues

10.3.1  Display Problem with Agent Console Interfaces

If you run the agents with an agent console interface in languages other than English, the display 
of logging information might not display correctly. The problem occurs if your language encoding 
is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.

2 Select the language you are running the agents in, then click Details.

3 Deselect Use UTF-8 Encoding, then click OK.

4 Stop and then restart the agents to put the new setting into effect.

10.3.2  Extended Characters in Attachment Filenames

If you are using the WebAccess client in the Konqueror browser, you cannot attach files that have 
names including accented characters. Konqueror does not send the filenames back in UTF-8 
format.
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10.3.3  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be 
set explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform 
client. Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables 
and resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

10.3.4  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

10.3.5  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

11.0  Documentation Issues

11.1  General Documentation Issues
None.

11.2  NetWare Windows Documentation Issues

11.2.1  GroupWise 6.5 Help

To support accessibility requirements within GroupWise Help, the Help for all GroupWise 
components uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.
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11.3  Linux Documentation Issues

11.3.1  Right-to-Left Text in Cross-Platform Client Help

Languages that display right-to-left display right-justified rather than left-justified.

11.3.2  Web Link in ConsoleOne Help

The link from the ConsoleOne help to the Novell GroupWise documentation Web site does not 
work. This problem will be addressed in a future version of ConsoleOne. In the meantime, you can 
copy the URL from the ConsoleOne help topic into your browser window in order to access the 
GroupWise documentation Web site.

11.3.3  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and 
if iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

12.0  Defect Fixes

12.1  Address Book Fixes
If you drag and drop names from a personal address book to the body of a message, the names 
are copied (not cut) from the address book and then pasted.(358311)  

Free-form e-mail address information for users in groups is saved in personal address 
books.(382234) 

When you save a group from the GroupWise Address Book into a personal address book or 
your Frequent Contacts address book, the members of the group are listed in the copy of the 
group.(392942) 

When you search for a recipient in an LDAP address book from the Mail To window, the client 
now sends an LDAP BIND request prior to the search.(359156) 

All information from a vCard 2.1 file from a Palm desktop is imported into the address 
book.(370264) 

You can send a message from the Address Book to a recipient whose name includes extended 
characters.(100368887) 

12.2  Administration Fixes
On the POA Schedule Events tab, debug information no longer pops up when you add or edit 
a scheduled event.(398166) 

You can add an External Entity on the Membership tab of a restore area.(100369042) 

You can use the Backup/Restore Mailbox feature for a user who is an External 
Entity.(100369278) 

The Validate Database option in ConsoleOne identifies and removes second occurrences of 
the same field in a single record in a database. (355454) 

When you create a new domain or post office on Linux, the location is stored in UNC path 
format, not a Linux path.(398376) 
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The My Computer button in the Select Domain Database dialog box works correctly.(393211) 

Repaired user records are no longer given unknown GUIDs by a structural rebuild.(391816) 

12.3  Admin API Fixes
None.

12.4  Agent Fixes
If the POA identifies that its HTTP port is already in use, it displays the correct error 
message.(397747) 

The POA handles SSL connections with MTAs reliably. (398752, 898563, 398922) 

Fixed some POA abends.(393552, 398497, 394742, 100369346) 

The MTA respects the Maximum Send Message Size Limit for messages that are outbound to 
the Internet.(100368629) 

12.5  Client Fixes (Windows)
You can forward an item that has an attachment but no body text.(381077) 

If you select an item in your mailbox, right-click in the Date column, then click Filter, the 
Filter dialog box displays correctly.(361942) 

If multiple users access their mailboxes from the same workstation, the archive path is 
retained correctly for each user.(394388) 

All items in a shared folder are downloaded to the Caching mailboxes of users with whom the 
folder is shared.(384805) 

When items are archived from a mailbox that belongs to a resource and then unarchived, they 
are placed in the Online mailbox of the resource.(395382, 391683) 

If you reschedule an appointment addressed to a group by dragging and dropping it in your 
Calendar, the appointment is rescheduled for members of the group.(379005) 

If you drag and drop an appointment from the day or week view of your Calendar to the 
Attachments field of a message, the “not allowed” icon no longer displays.(365793) 

If you use the Auto Select feature of a Busy Search, the grid showing schedule conflicts 
displays correctly.(399633) 

If you create a posted phone message and edit it, the text from the body of the message no 
longer appears in the Subject line.(361192) 

If you have a distribution list that includes CC and BC recipients, and if you expand the 
distribution list in the Address Selector dialog box, CC and BC recipients are correctly 
expanded into their respective recipient types.() 

When using Auto-Accept and Auto-Delete rules to schedule appointments for resources, you 
can resend a modified appointment and it is successfully modified in the resource’s 
calendar.(372210)  

When editing the actions for a rule that includes adding an attachment, editing the file multiple 
times does not cause the file to be attached multiple times.(390336) 
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If you proxy to another user and then return to your own mailbox, the Mailbox Size field 
correctly displays the size of your mailbox, not the size of the mailbox you proxied 
into.(100369096) 

If you have two users with the same username and last name but located in different post 
offices, you can successfully proxy to both users by selecting them from the Address Book 
without receiving a D102 Ambiguous User error.(100369390) 

The Junk Mail Handling feature identifies messages from recipients with usernames starting 
with a percent sign (%) as junk mail and places them in the Junk Mail folder.(380341) 

You can use shortcut keystrokes (Ctrl+C, Ctrl+X, and Ctrl+V) to move recipient names 
among the To, CC, and BC fields of a new message.(398701) 

You can save an attachment and import a document on a workstation that has a hidden 
drive.(399338) 

During installation, Microsoft Office 2003 is now listed on the Software Integrations 
page.(394510) 

SetupIP runs to completion when the Web server is Microsoft IIS.(386924) 

If the text of a message body is modified by a CAP or SOAP client, the change appears in the 
GroupWise client.(391711) 

Extended characters display correctly in the subject line.(391654) 

In international versions, you can successfully display the properties of an 
attachment.(100351007) 

In the Japanese client, highlighted URLs successfully open the browser and display the linked 
Web page. (370637) 

In the Japanese client, text in the dialog box that appears for accepting, resending, and deleting 
an appointment displays in Japanese.(394918) 

When you reply to an HTML format message that includes Kanji characters, they display 
correctly in the body of the reply.(383991) 

The display of a Japanese punctuation mark has been corrected.(100368914) 

12.6  Client Fixes (Cross-Platform)
The Cross-Platform client starts successfully in Portuguese on a Portuguese Linux 
workstation that uses the KDE desktop.(399146) 

12.7  Client API Fixes
The limits on the number of messages in the Messages and QuickMessages collections have 
been removed.(400846) 

You can successfully access QuickMessages and Accounts::Refresh from multiple users when 
each user is running in a different thread.(401167) 

The Client API can read a message in a shared folder.(392408) 

The Client API can consistently access new folders and delete items from trash.(401898) 

The Client API can successfully get the Categories object for an address book entry.(390492) 

A message is sent successfully when the MultiLoginAddressBookSupport flag is set to TRUE 
and the Recipients.AddByDisplayName method is used.(394462) 
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The pIGWCategory->Release() method no longer causes a crash in the client.(390487) 

12.8  Engine Fixes
The IMAP logic checks for very large tags on IMAP commands to prevent buffer 
overruns.(394860) 

The IMAP FETCH command no longer truncates data during archiving.(398726) 

UID commands return the correct response on failures.(396334) 

The iCal parser can handle a line wrap in the middle of a word.(395494) 

The <CR><LF> sequence is now escaped to accommodate some iCal parsers.(394573) 

The CAP logic now handles modifying an appointment, so that the original appointment is 
retracted, modified, and then resent.(402060) 

12.9  GWCheck Fixes
The new ClearTZ Support option removes Time Zone fields from user databases to help 
resolve problems that occasionally arise when switching to and from daylight saving time. 
These time zone settings pertain to the WebAccess client, not the Windows or Cross-Platform 
client.(358012) 

The DelSubscribeRecords Support option correctly deletes subscriber records for invalid 
users and resources.(389855) 

The ForceClean Support option successfully checks all records on the message 
database.(100369332) 

If you use the GroupWise 6.5 GWCheck to run a Contents Check on a GroupWise 6 mailbox, 
you no longer get a Sent Items.dup1 folder in the mailbox. In addition, the DelDupFolders 
Support option now removes any existing Sent Items.dup1 folders that might have been 
created in users’ mailboxes in the past.(100369017) 

12.10  Internet Agent Fixes
When processing messages, the Internet Agent uses Quoted Printable encoding, so that it puts 
in soft returns rather than hard returns when wrapping text.(398389) 

When the Internet Agent is configured to function as an LDAP server, it returns the user’s e-
mail address along with first name, last name, and phone number information.(397919) 

The /log startup switch no longer causes memory allocation errors.(383678) 

Pathnames are set up correctly when using the /cluster switch in a clustering 
environment.(100368730) 

Fixed some Internet Agent abends.(388609, 100369025, 392898, 397869) 

12.11  Monitor Fixes
If an agent is in the Unknown status, a notification is generated.(100369035) 

Browser display problems caused by incorrect MIME encoding have been resolved so that 
status information displays correctly.(396972) 
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12.12  WebAccess Fixes
In the WebAccess client, a user in a post office that uses LDAP authentication can 
successfully proxy into a mailbox in a post office that does not use LDAP 
authentication.(399663) 

The Linux WebAccess Agent successfully logs status information when the --show switch is 
not used and when the WebAccess Application is running on a different server from where the 
WebAccess Agent is running.(395989) 

Fixed some WebAccess Agent abends.(385380) 

On NetWare 6, the WebAccess Application communicates more reliably with the WebAccess 
Agent.(360895) 

13.0  Additional Documentation
In addition to this Support Pack Installation Readme (readmeus.txt), the following sources give 
information about the Support Pack:

For the latest GroupWise 6.5 documentation, see the GroupWise 6.5 Documentation Web 
page (http://www.novell.com/documentation/gw65). It has been updated to correspond to 
GroupWise 6.5 Support Pack 4.

For information on the latest Support Pack issues, see the Consolidated Support Pack 12 
Readme Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10094148.htm).

NOTE: The Readmes available when installing components from the GroupWise Installation program are the 
original GroupWise 6.5 Readmes. They do not contain Support Pack issues.

14.0  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark.

15.0  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity 
of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

You may not use, export, or re-export this product in violation of any applicable laws or regulations 
including, without limitation, U.S. export regulations or the laws of the country in which you 
reside.
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